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Program Overview
Click on the icon for an overview of 
Image Bonanza.

Tutorial
Click on the icon for directions on using
Image Bonanza.

Menus
Click on the icon to read 
descriptions for every menu item.

Tools
Click on the icon for information 
regarding Image Bonanza tools.

 

Product Support 
Click on the icon for information on 
Expert's Product Support policy.

Frequently Asked Questions
Click on the icon for answers to the 
most commonly asked questions.

For Help on Windows Help click here For Help using Expert's help system click here  
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Program © 1997 Expert Software, Inc.
© 1997 Expert Software, Inc. All Rights Reserved. Design and documentation ©1997 Expert Software, Inc. Program 
Development. The user's guide and the software described in it are copyrighted with all rights reserved. The user's 
guide or software may not be copied in whole or part, without written consent of Expert Software, Inc. You may not 
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Program Overview
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Welcome to Expert's Image Bonanza!
This collection contains numerous images which can be used in a variety of documents. This online manual contains 
instructions for using the images in a variety of programs as well as how to use the Kudo Catalog Reader to print and 
preview the images before placing them into a document. This chapter covers registration procedures, installation 
instructions, and how to get started using the Kudo Catalog Reader.
Terminology used in this manual
Please note, Note, Hint, or Tip: Additional or background information on a command or procedure.
Choose File—Open: Choose a command from the applicable menu item. In this case, the command means to go to 
the File menu and select the Open command.
1, 2, 3, etc.: Sequential steps that are numbered in order of execution. Start with step 1 and proceed through the next
step in order to complete the procedure being described.
Drag & Drop: Press and hold the mouse button, then drag or move the mouse. Release the button when the 
movement is finished. 
Control Menu Box: The hyphen-shaped icon is located in the upper left corner of dialog boxes and windows. By 
double-clicking on the icon, you will close the current application. This functions as if you had pressed the ALT key 
and the F4 key at the same time.





Usage Rights and Restrictions
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You may:
Copy the CD on one computer hard drive and use the images on that computer.
Use, copy, modify and publish any of the digitized media contained in the program for use in advertisements, 
newsletters, public, private and business presentations, and other uses, provided the actual media is not being sold. 
For example, you can use the image(s) as an embedded image(s) in the program such as a background screen, but 
not as a program file, such as a *.WMF or other picture format.
Use the media to create calendars, greeting cards, posters or other items which are not intended for sale.
Use the media as part of a software product, provided the user does not have access to the actual media files.
If you create a Web page using images found in the photo CD and intend to distribute and sell these calendars, this is
a violation of the license agreement.
You may not:
Make copies, film negatives or positives, magnetic copies of the images of the CDs for sale, rental, lease, or transfer 
to another person or entity, other than the permitted user.
Distribute any of the media as part of any software product(s), in electronic file formats such as *.PCX, *.WMF, *.BMP,
*.EPS, *.PICT, *.GIF, *.MOV, *.AVI, *.WAV, *.JPEG, etc.
Copy the program(s), alter, modify or adapt them.



Copy, decompile, disassemble, modify, translate or create derivative programs based on the applications embedded 
in the program(s).
Use or alter, in whole or in part, a digitized image in any manner for pornographic use.



Additional Information
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The following categories are listed in the Kudo Browser:

Kudo Browser
Categories:

Font Categories Include: JPEG Categories
Include:

AVI Categories 
Include:

Sound 
Categories 
Include:

Animals
Borders
Cartoons
Occasion
Onwheels
Holiday
Sayit
Onthejob
Health
Leisure

Aladdin
Anastas
Anglican
Aristocr
Astute
Bailey
Bucknghm
Chowmein
Cocktl
Composer
Cowspots

Phinsth
Prawnhnd
Promenad
Pyxidmq
Quantbr
Quarkneo
Revellt
Rockney
Rodeo
Schoolb
Schwrzld

Building
Bodywtr
Fruitveg
Activity
Mountsky
Industry
Landscap
People
Plants
Textures

Corp
Advrtsng
Backgrnd
Holidays

Animal
Entertnm
Follies
Househld
Houseobj
Military
Misc
Music
Object
Ondajob
Outdoor



Daniela
Debvcir
Elisia
Evita
Funkface
Gallery
Gatsby
Gecko
Ghoulcap
Ghoulsol
Goldston
Grailnew
Greatshd
Gymnast
Hallween
Highnoon
Hndybrsh
Hollywd
Jojnhnck
Jurassic
Ladybug
Larisslt
Lettrman
Linocutr
Logan
Luftwaff
Maraca
Marlboro
Medflyl
Muschall
Neoncaps
Neonthck
Newmex
Oldengl
Parade
Parkplc
Pentip

Scndgrdr
Sharny
Sheerb
Silvrplt
Snowtops
Sprint
Stadgbk
Stadghi
Starstrp
Stensnxb
Swisschs
Technici
Tolkien
Trifles
Vivacs
Yucatan

Transprt

Expert Software recommends that the *.WMF format is utilized for clearest resolution at optimal file size. To use the 
*.WMF images, go to the d:\content\directory (where d:\ is the drive letter of your CD-ROM) where the images are 
broken down into sub-categories. 
Note: You must have *.WMF, *.WAV, *.JPEG, *.AVI filters or an application that is able to open format files to view 
these media.



Registration, On-Line Catalog Information
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By registering, Expert Software, Inc. can keep you informed of the latest changes and improvements to this product, 
as well as information on our other products. Sending in your registration card also allows you to receive free product 
support.
To register this product, either fax via modem or print the registration form.
Note: If you did not register during installation, you need to re-install the program in order to redisplay the Expert 
Software Registration Card.
To fax your product registration using the modem:
1. Fill out the appropriate information in each field.
2. Click on the COM Port section field to display a list of available ports.
3. Select the appropriate Port for your computer.
4. Click on the Fax Card button to transmit the information.
TIP: If you don't know what Port your fax modem is connected to, try a different COM Port number.
If you prefer, you can print the registration card and print it by clicking on the Print Card button. Fax the printed form 
to: (305) 569-1350. Or mail it to: 
Mail to: Expert Software, Inc.

P.O. Box 144506



Coral Gables, FL 33114-9796
Fax it to: (305) 569-1350
Starting the Online Catalog
After you register the program, the Online Catalog is installed. To access the Online Catalog which allows you to 
preview other exciting Expert products:
Windows® 95 users
Insert the Expert CD into your CD-ROM drive. On the Taskbar, click on the Start button, point to the Programs folder 
then the Expert Software folder and finally, point and click on Expert Online Catalog.
Windows® 3.1 users
Insert the Expert CD into your CD-ROM drive. Locate the Expert Software program group and maximize or double-
click on it. Once it opens, double-click on the Expert Online Catalog icon.Microsoft Video for Windows
To launch the installation of Microsoft Video for windows, choose File—Run then go to d:\mvfw\setup. Watch a demo 
of Expert's other Clip Art products by running clipart.avi located in the Expert folder.



Using Kudo Browser
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The Kudo Catalog Reader enables you to open catalogs of images in various distinct categories. Each category is a 
separate catalog. The Kudo Image Browser catalogs the image files using thumbnails. Think of a thumbnail as a 
miniature photo of the image file. It looks like the file, but it's a replica that takes up very little memory. Kudo uses the 
thumbnail in its catalog and leaves the image file untouched in its original form and location. With these compact 
thumbnails, Kudo catalogs the image files in a convenient, accessible way.
The thumbnails provide a visual reference for each image file. Kudo adds information, such as the original file's 
name, location, size and file type to complete the catalog.
The Kudo Catalog Reader Window
Kudo allows you to view image thumbnails in three ways: gallery, small gallery, and list views. The illustration is a 
typical Kudo Catalog Reader window. The catalog selected is being displayed in the Gallery View.
Please note: The Kudo Catalog Reader displayed is an example and may not reflect your onscreen images or the 
categories available on your CD-ROM.



Kudo Browser Interface
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Kudo allows you to view your image thumbnails in three ways: Gallery, Small Gallery, and List views. This is 
a typical Kudo Image Browser window. The catalog selected is being displayed in the Gallery View. 
(Please note: The Kudo Window displayed below is an example and may not reflect your onscreen images.)



See Also:
Installing True Type Fonts in Microsoft® Windows®

Installing TrueType Fonts in Microsoft® Windows® 
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1. Place the Expert CD into your CD-ROM drive. From Microsoft® Windows® Program Manager, double-
click on the Image Bonanza icon located in the Expert Software program group. The Fonts dialog box 
appears:

2. Click on the drop-down list box and select a Font family. All the fonts for that family are displayed in the 
larger box.
3. After highlighting the desired fonts, click on the Install Selected Fonts button.
4. To make multiple font selections, press the CTRL key while you click on the desired fonts.
5. After installing the desired fonts, this window appears to confirm your selection. Click on the OK button.

Note: It is recommended that you do not have more than 20 fonts installed on your system at one time. For 
Win 95 users, after installing the fonts, click on the Fonts icon in the Control Panel to update the fonts folder. 
All fonts will be visible in the application.



Tools
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This is Web Site Clip Art's Toolbar:

See Also:
Tutorial
Menu
Keyboard Short Cuts

Small Gallery View button
The Small Gallery View button uses the same layout as Gallery, but with much smaller images, 
allowing the user to view more images at once. The filename is not displayed in this view. Click on 
the Info button to view detail about the selected thumbnail. This command can be activated by 
choosing View—Small Gallery.

Gallery View button



The Gallery View button uses a grid-style layout showing several thumbnails and their file type 
and size at once. Click on the Info button to view detail about the selected thumbnail. This 
command can also be activated by choosing View—Gallery.

List View button
The List View button uses a vertical layout with fewer thumbnails in the window than the Gallery 
view and a blank notes section. The List View shows the thumbnails in the first vertical column and
the blank notes section in a second vertical column. Simply click on one of the three View buttons 
to toggle to the view desired. This command can also be activated by choosing View—List.

Menus
These are the menus commands, offering you access to the menu options. See Menus for more 
information.

Menus
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See Also:
Tutorial
Keyboard Short Cuts
Tools

File Menu
To select any of the help lessons, click with the mouse when you see the  cursor.

 
The File menu contains commands for accessing and printing the 
images.
See Also:

Tutorial
Keyboard Short Cuts
Tools

This option will close the currently open browser file, but will keep the browser program on.    To close a 
browser file and turn the browser program off simultaneaously, use the Exit option in the file menu.



This option will give you the standard Windows Open Dialog box.    From this box you may open other 
browser files with the *.KDB extension on them.



Use the standard Printer Setup and Print commands to print part or all of your catalog. The Print feature 
always prints the current selection of thumbnails. For example, to print all thumbnails in a catalog, choose 
Image-Find All to find everything, then choose File-Print.
To print thumbnails with file name and size only, select the Gallery View prior to printing your catalog. 
Printing a catalog in Small Gallery View prints the maximum number of thumbnails per page. To print 
thumbnails with complete information, including file location, select List View and then print the catalog. 
Printing a catalog in the Gallery View, Small Gallery View and List View buttons allow you to toggle between 
views. Switch between views by clicking on the view button you prefer. List View provides more text 
information on images, but prints fewer thumbnails on each page.



Printer Setup gives options to select available printers and change their options.
1. Select a printer and port.
2. Click on Setup to open the Setup window and choose the print quality, paper orientation and size.
3. From the Setup window, click on Options to choose additional printer specific options.
4. Click on OK on each window to accept the changes.



The Exit command closes the open catalog and then closes Kudo.



Edit Menu
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The Copy Text option is always grayed-out. Only the Copy 
Thumbnail option is available.
See Also:

Tutorial
Keyboard Short Cuts
Tools

The Copy Text option is always grayed-out. Only the Copy Thumbnail option is available.



Copy Thumbnail copies the selected thumbnail in the currently active catalog. To retrieve the object from the 
clipboard, choose Edit-Paste from the menu of the target application.



View Menu
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To select any of the help lessons, click with the mouse when you see the  cursor.

 
The View menu allows you to choose from three viewing options.
See Also:

Tutorial
Keyboard Short Cuts
Tools

The Small Gallery View uses the same layout as Gallery, but with much smaller images, allowing the user to 
view more images at once. Click on the Info button to view detail about the selected thumbnail.
The Small Gallery View, Gallery View and List View buttons allow you to toggle between views. Switch 



between views by clicking on the view button you prefer.



The Gallery View uses a grid style layout showing several thumbnails and their file type at once. Click on the 
Info button to view detail about the selected thumbnail.
The Gallery View, Small Gallery View and List View buttons allow you to toggle between views. Switch 
between views by clicking on the view button you prefer.



List View uses a vertical layout with fewer thumbnails in the window, but with more information about each 
file. The list view shows the thumbnails in a vertical column. This program does not provide additional 
information in the notes section, therefore the second vertical column in the list view will always be empty.
The List View, Gallery View and Small Gallery View buttons allow you to toggle between views. Switch 
between views by clicking on the view button you prefer.



Image Menu
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The Image menu provides you options on finding, previewing and 
getting information for your selected thumbnail.
See Also:

Tutorial
Keyboard Short Cuts
Tools

Kudo maintains a link between the thumbnail image in the catalog and the original file. Use the Preview 



option to preview the original image file in a full-sized window.
1. Select the thumbnail you wish to preview.
2. Choose Image-Display Original.
3. Kudo will find the original image file and display it in a full-sized window.
4. Double-click on the Control menu box (the hyphen-shaped box in the upper left corner of the window) to 

exit the preview window.
To preview other image files, simply click on their thumbnails while the Image Preview window is open. On 
some systems Kudo may need help finding the original image. If you see the dialog box (shown below) enter 
in the correct letter of your CD-ROM drive and click on OK. Kudo will now be able to find the original images.



Get info gives you quick access to a thumbnail's information. This option tells you the file name, volume, 
size, date created, location and any notes attached to the thumbnail.
Note: Only the name and size will be distinct for each.
To display a thumbnail's information:
1. Select a thumbnail.
2. Choose Image-Get Info.
3. Kudo will display the information in the floating window, Image Information.
4. Double-click on the control menu box (the hyphen-shaped box in the upper left hand corner of the 

window) to exit the floating window.
Note: if you edit the information in this dialog box, it will not be saved because it is being read from the CD-
ROM.



Use the Find feature to search the catalog for thumbnails with specific characteristics. Kudo searches the 
catalog and displays the thumbnails that were identified in the search. All other thumbnails are hidden from 
view.
When you select the Find button (or choose Image-Find), Kudo displays the Find Image dialog box.
1. Use the first combo box to tell Kudo which thumbnail characteristic it should search. You can search by 

name, size, date modified, notes or location. Note: Only searching by name or size will produce a distinct
find.

2. Use the next combo box menu to tell Kudo how to search the catalog. The selections in this combo box 
will become available after you make a selection in the first combo box.

3. Use the edit text box to tell Kudo for what words or information to search. Wild card characters such as *
or ? are not necessary.

4. Click on Find.



Find All searches for and displays all thumbnails in the active catalog. This feature is also used to restore all 
thumbnails after a Find operation. Find All is equivalent to executing a Find Everything using the Find button.



Sort Menu
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The Sort menu allows you to sort thumbnails according to 
the certain criteria. Note: Only sorting by name and size 
will produce a unique sort; all other characteristics are 
identical for all.
See Also:

Tutorial



Keyboard Short Cuts
Tools

Sorts by eight character file name.



Sorts by size of the actual image file (bytes).



Alphabetically groups thumbnails by their image type (extension).



Sorts by date the image file was last modified.



Sorts by image file's location pathname.



Sorts by first word in the Notes Box.



Window Menu
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The Window menu allows you to manipulate the currently 
displayed window.
See Also:

Tutorial
Keyboard Short Cuts
Tools



Arranges open windows so that the title bar of each window is visible.



Arranges open windows side by side so that all of them are visible.



Arranges into rows all program-item icons for a selected group.



Closes all open catalogs.



Lists the names of currently open browsers.



Help Menu
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The Help allows you to access credits, this help file, and 
the Windows help file.
See Also:

Tutorial
Keyboard Short Cuts
Tools

Launches this help file.



Launches the Windows Help on Help File.



Launches the Kudo Image Browser About box.



Tutorial
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Placing Images Via Kudo
Through the Kudo Reader, users are able to preview the images as well as place them into other applications. There 
are two methods for placing an image from a Kudo Catalog into a document:
Copy and Paste, and Drag and Drop
Copy and Paste
1. Choose Edit—Copy Thumbnail to copy the selected image in the currently active catalog to the Clipboard Viewer.
Note: Once an object has been copied to the clipboard, it is simple to Paste the image into another application. The 
actual image, not the thumbnail, is copied to the clipboard.2. To retrieve the object from the clipboard, choose Edit—
Paste from the menu of the target application.
Drag and Drop
Kudo takes advantage of Windows technology (DDE and OLE 2.0) which allows you to Drag and Drop images into all
popular graphics applications. When you Drag and Drop from your Kudo catalog to an open document, Kudo will find 
the original image file and place it in the document of selected desktop publishing and other page layout applications, 
with pinpoint accuracy.
To Drag and Drop a thumbnail to an open document:
1. Open the Target Document and open the Kudo Reader. Size both applications, so that they can both be seen on 
the screen.
2. Select the thumbnail to be moved to the target document.



3. Hold down the mouse button and drag the image to the open document. The cursor will change when you are able 
to drop it onto the document. If an "X" appears on the cursor, you cannot drop the thumbnail onto the target 
document.
The following applications support Drag and Drop:
• All graphics applications support Drag and Drop from the File Manager. This includes virtually all leading 
applications.
• All graphics, desktop publishing, and multimedia applications that are OLE 2.0 clients. OLE 2.0 clients provide 
pinpoint accuracy when dropping onto a page layout.
• Kudo includes Place Modules for the following applications that are not OLE 2.0 clients, but could benefit from Drag 
and Drop:

QuarkXPress® version 3.12. 3.2 and 3.3
Adobe® PageMaker® version 4.2 and 5.0
Microsoft Word® version 2.0*
WordPerfect® 6.0

Note: For Microsoft Word users, Word will indicate that you can drop the image only when the cursor is over the 
Word application toolbar or status bar (along the bottom of the window). When the image is dropped, it will be 
inserted at the exact location of the Word "I-beam" (insertion point). Release the mouse button and Kudo will find the 
image and place it into the document.



Using the Images in Various Applications
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The following programs are covered in this section: Microsoft Word Pad, Microsoft Word, and Quark XPress. Please 
see your manufacturer's user guide for more detailed information on using the images with other programs.
Microsoft® Word Pad (Windows® 95)
1. Open or create a Word Pad document.
2. Choose Insert–Object.
3. Select Bitmap image in the Drop-down menu.
If you have any questions, call Microsoft Windows support.
Microsoft® Word® 6.0
1. Open an existing Word document.
2. Choose Insert–Picture.
3. In the dialog box that appears, change the drive and directory to locate the image. All of the images for the Kudo 
Catalogs are located on the Expert CD.
4. Select the image you want to use and click on the OK button.
5. Place the cursor anywhere on the document.
If you have any questions, call Microsoft Word support. 
QuarkXPress® 3.1–3.3
1. Open an existing QuarkXPress document.



2. Select the desired picture box tool from the toolbox.
3. Create a picture frame by dragging and dropping the mouse to the desired size and area of the page.
4. Choose File—Get Picture.
5. In the dialog box that appears, change the drive and directory to locate the image. All of the images for the Kudo 
Catalogs are located on the Expert CD.
6. Select the image you want to use and click on the OK button.
7. Place the cursor anywhere on the document.
If you have any questions, call QuarkXPress technical support.



Find Button
Use the Find feature to search the catalog for thumbnails with specific characteristics. Kudo searches the catalog 
and displays the thumbnails that were identified in the search. All other thumbnails are hidden from view.
When you click on the Find button (or choose Image—Find), Kudo displays the Find Image dialog box.
1. Use the first combo box to tell Kudo the thumbnail characteristic it should search. You can search by name, size, 

date modified, notes or location. Note: Images in a catalog will only have a distinct name and size. All other 
characteristics are the same for all images.

2. Use the next combo box menu to tell Kudo how to search the catalog. The selections in this combo box will 
become available after you make a selection in the first combo box.

3. Use the edit text box to tell Kudo for what words or information to search. Wild card characters such as * or ? are
not necessary.

4. Click on Find. Note: When you exit from the catalog and reopen it, all images in the catalog will be found.



Info Button
The Info button gives you quick access to a thumbnail's information. This option tells you the file name, volume, size, 
date, location of file and any notes attached to the thumbnail.
Note: The date, volume and notes will contain the same information for all images.
To display a thumbnail's information:
1. Select a thumbnail by clicking on it.
2. Click on the Info button.
3. Kudo will display the information in a floating window, Image Information.
4. To close the window, double-click on the control menu box (the hyphen-shaped box in the upper left corner of the

window).
Note: If you edit the information in this dialog box, it will not be saved because it is being read from the CD-ROM.



Riffle Feature
The Riffle feature displays the selected catalog's thumbnails one at a time in the lower right corner of the main 
window.

Control the Riffle speed and direction by holding down the left mouse button and dragging the control bar from the 
center to the left or right of the Riffle Control. Kudo will advance through the catalog until you release the control or 
until it reaches either end of the catalog.
When the mouse button is released or the control bar is returned to the center position, Kudo stops near the 
thumbnail that you chose and displays the surrounding thumbnails. Your reactions may be slower than Kudo's Riffle 
feature, so when you release the Riffle control, you may have to select a thumbnail that is a few frames ahead of the 
one you wanted.



Status Bar
The Status Bar displays the number of thumbnails currently displayed out of the total number of thumbnails 
contained in the active catalog.
For example, the active catalog contains 100 thumbnails. After executing the Find feature, only 35 thumbnails met 
the search criteria. The catalog window will only display the 35 found thumbnails and the Status Bar will display "35 
of 100 found."
To restore the catalog to the full 100 displayable thumbnails, use either the Find All option from the Image Menu or 
find "Everything" using the Find button.



Sorting
When you open a catalog, Kudo lists the thumbnails according to when they were added to the catalog. Use the Sort 
menu to list the thumbnails by file name or size. You can sort the catalog using the same criteria found in the Find 
feature.
Sort and Find use the same criteria but they affect the catalog differently. With Find, you use the criteria to determine
which thumbnails Kudo should display and which it should hide from view. With Sort, you re-arrange the thumbnails 
that are displayed.
When you close and re-open the catalog, Kudo shows all the thumbnails in their original order.
To sort your catalog:
1. Select a sorting criteria from the Sort menu (name or size).
2. Kudo will automatically re-arrange the thumbnails and display them in their new order.
Note: Only sorting by name or size will produce a unique sort.



Keyboard Short Cuts
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File Menu
Print Ctrl+P
Exit Alt+F4
Close Ctrl+W
Open Ctrl+O
Edit Menu
Copy Thumbnail Ctrl+C
View Menu
Small Gallery Ctrl+S
Gallery Ctrl+G
List Ctrl+L
Image Menu
Display Original Ctrl+E
Get Info Ctrl+I
Find Ctrl+F
Find All Ctrl+A



Help Menu 
Index F1



Thumbnail
A thumbnail is a small picture of your original file. Thumbnails allow you to preview your image before selecting it. 
Select a thumbnail by clicking on it. 
Double-clicking on a thumbnail will open the paint program you have associated with the image extension. If no 
association exists, nothing will happen.



Image Information
This area displays the file name and size of the original image.



Frequently Asked Questions
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Q: How do I import the images into my application?
A: By following the steps necessary for that application, click here for specific applications.
Q: How do I save the text entered under the List View note field?
A: This program was designed to view thumbnail images rather than to create new ones.    If the 

program allowed for the creation of new browsers, then the note field would save notes or 
information entered in the field.

Q: How come when I double-click on an image nothing happens?
A: Verify that the selected image is being associated with a BMP or PCX extension or any other 

compatible paint program.
Q: How can I easily edit the image?
A: If you double-click on an image's thumbnail it will be opened in Paintbrush or any other paint 

program associated with a BMP or PCX extension.
Q: What do I do when I get the error message file not found?
A: To preview other image files, simply click on their thumbnails while the Image Preview window is 

open. On some systems Kudo may need help finding the original image. If you see the dialog box 
(shown below) enter in the correct letter of your CD-ROM drive and click on OK. Kudo will now be 
able to find the original images.





Click here to choose a font family. 



These are the fonts available for the font families. Font families can have from 1 to 10 fonts.



Clicking here will install all the selected fonts to your system. 



This exits from the Font Installer.



This launches the help file.



How to use Expert Help
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

To select any of the help lessons, click with the mouse when you see the  cursor.
Expert help uses a visual system for providing you with information on the different screens and features of this 
program.

To obtain help on any topic, click on the Help menu from anywhere in the program or on the 

 icon. Doing so brings up the appropriate help topic for the current screen that you are on.
Most of the major screens and dialog boxes in this program are reproduced in miniature form in this help file.

As you pass the mouse cursor over the image, the arrow-pointer changes to the shape of a hand 
 indicating that you can click on that area. (This is called a "hotspot.") For information on any field, button, hotspot, 

or feature, simply click on the area you are interested in and a pop-up description appears or it jumps you to that 
specific topic. Occasionally, you see the Expert "X" (

) in some portions of the help file preceded by "click here;" it will be a jump to another topic or location in the help 
file.

The pop-up or jump description may consist of up to 3 parts. They include:
Definition and/or general information about the item you have selected.
Action to take. Any instructions or options available for the topic.
A link (usually in green) to a related topic. If further information is available for the item you have 
selected, the link will take you to the new topic of interest.



Another way of quickly accessing information for a particular topic is through the use of the glossary buttons 
located in the non-scrolling region at the top of every help screen. Clicking on each letter provides you with a quick 
alphabetized index listing in a pop-up box.



Product Support
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For information on an item, click on it with the mouse when you see the  cursor.
Your purchase of an Expert product includes free product support to help you get the most out of your software. All 
Expert products are thoroughly tested and come with a Help File, User's Guide and/or Online Manual. In most cases, 
the answers to many of your questions are in the Help File, User's Guide and/or Online Manual.
If you are having problems starting or running the program, please feel free to contact us. 
24 Hour Automated Support

 Find answers to frequently asked questions on the worldwide web at http://www.expertsoftware.com
 Use our Fax Back System for support and product information at (800) 772-5706. 

E-mail Addresses
 You can send e-mail to support@expertsoftware.com or sales@expertsoftware.com

Mailing Address
 800 Douglas Road, Suite 750, Coral Gables, FL 33134 or
 P.O. Box 144506, Coral Gables, FL 33114-4506.

Telephone Product Support
Contact a friendly Expert Product Support Specialist Monday through Friday, 9:00AM to 5:00PM EST (Eastern 
Standard Time). Telephone (305) 567-9996 or fax (305) 569-1350.
If you call, you should be at your computer. Be ready to give the Product Support Specialist the 10-digit program 
version number from the front of your program disk or back of the CD jewel case, as well as the following 



information:
If you have a Macintosh®–compatible computer

 Please have the model, system software version and amount of memory available.
If you have Windows®– or MS-DOS®–compatible computer:

 The version of DOS that is installed on your computer. (You can determine the version by typing VER at the DOS 
prompt.)

 The version of Windows® installed on your computer.
 The type of hardware you are using:

The brand of computer you own, 
CPU type (80386, 80486, Pentium®), 
Video type (EGA, VGA, Super VGA),
Model and type of video card, and 
Model and type of printer.

 The exact wording of any messages that appeared on the screen.
 What happened and what you were doing when the problem occurred.

We encourage Windows® 3.x (or MS-DOS 6.x) users who need product support to print an MSD report. Have it 
available for the Product Support Specialist who answers your call. You will find the MSD (Microsoft Diagnostics) 
program in either the Windows or the DOS directory.
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